Best Practices for Using Ricoh’s Universal Printer Drivers in Microsoft Print Server Environments

Table of Contents

Overview ............................................................................................................................. 2
Description ......................................................................................................................... 2
Support ............................................................................................................................... 2
Setup .................................................................................................................................. 4
Best practices ...................................................................................................................... 5
Installing the Ricoh PCL6/PS Universal Print Driver .......................................................... 6
Frequently asked questions ................................................................................................. 9
Known issues ....................................................................................................................... 10
Fixes ................................................................................................................................... 11
Supported Models ............................................................................................................. 17
Supported Operating Systems ......................................................................................... 26
OVERVIEW

This document outlines best practices for using Ricoh Universal Printer Drivers in the Microsoft® Print Server environment. It also details known issues relating to the PCL6 UPD, PS UPD, and Print Server environments. It is intended to be a guide for use in the planning and pre-deployment stages of the Ricoh UPD. By reviewing this document thoroughly, you will greatly increase the success rate of deploying the UPD in your server environment and reduced the amount of client, server, and application issues that could affect the performance of the UPD.

DESCRIPTION

Ricoh's Universal Print Driver provides a single intelligent advanced driver, which can be used across your fleet of Multifunction Products and Laser Printers. The Universal Print Driver lets you simplify printer support and lower management costs without sacrificing the features important to your users.

SUPPORT

First, please verify that your model is supported by the Ricoh UPD!

Non-Supported Models

Supported Models

SETUP

Ricoh recommends applying hotfixes associated with the Microsoft knowledge base (KB) articles listed below. Hotfixes could greatly increase printing performance!

Hotfixes that are directly associated with Windows Server that may affect UPD printing.

• KB article 982728 - “Windows cannot connect to printer” error message when you try to create a Point and Print connection to a remote printer from a Windows 7 or Windows Server 2008 R2-based client computer
• KB article 983401 - A long delay occurs when you print a large file on a Windows 7 or Windows Server 2008 R2-based computer
• KB article 2388142 - A computer that is running Windows 7 or Windows Server 2008 R2 intermittently cannot use a shared network printer to print
• KB article 919543 - The size of the EMF spool file may become very large when you print a document that contains lots of raster data
Hotfixes that are directly associated with Microsoft Office that may affect UPD printing.

- KB article 2121850 - A booklet layout setting does not work when you print a multiple-page document in Windows 7 or in Windows Server 2008 R2 if you use a printer driver that uses Unidrv.dll (After the hotfix is applied, install any of the built-in MS-PS drivers in order to overwrite the old pscript.dll. The new pscript.dll will be applied to all of the existing PS queues including the PS UPD).
- KB article 2345342 - In Office 2010, you print a PowerPoint presentation that is filled with images. In this situation, the operation results in an oversized spooler file.

When you turn Background printing on, you can continue to work as you print. However, sometimes printing presentations that contain graphics can drastically slow down the print process. If you are working on a presentation that requires rapid response time from the printer, turn Background printing off.

To turn background printing on or off, do the following:

1. On the Tools menu, click Options, and then click the Print tab.
2. Under Printing options, select or clear the Background printing check box.

- KB article 2553089 - Erratic print behavior when printing certain Microsoft Power Point 2007 files. For example, Only 6 pages print from a 10 page document. Charts and graphics are left out. Offending command errors at the end of the jobs
- KB article 2592142 - Office 2010 printing errors with Calibri font when printing through a Windows Server 2003 or 2008 print server

Hotfixes that are directly associated with Print Clusters that may affect UPD printing.

- KB article 822553 - slow printing performance
- KB article 838337 - an issue where the recently installed printer is not published
- KB article 835609 - an issue that results in the error "Unable to Install Printer. The Print Processor does not exist."
- KB article 976571 - Stability update for Windows Server 2008 R2 Failover Print Clusters

Best practices

Outlined below are two methods for installing product-specific drivers and the Ricoh Universal Print Driver (UPD) to a cluster environment.

**Installing the Ricoh PCL6/PS Universal Print Driver**

Ricoh recommends using the latest version of the Universal Print Driver, which can be found at [http://ricoh-usa.com/services_and_solutions/universalprintdriver/universal_print_driver.aspx](http://ricoh-usa.com/services_and_solutions/universalprintdriver/universal_print_driver.aspx)
Please review the Key Points to follow when creating TCP / Port section below. This could greatly increase printing performance!

**Key points to follow when creating the TCP/IP Port**

- Make sure the standard TCP/IP ports are created correctly (All default is the only right way).
- The SNMP status needs to be enabled and the community name needs to match the setting on your printer.
- Enable Bidirectional Support. (Ricoh's recommendation is to always enable bidirectional support).
- The SNMP Status box will be unchecked when the port is created while the printer is not on the network (staging) and the bidirectional function is also disabled because of this. (Ricoh's recommendation is to always enable bidirectional support).
- Do not use existing ports created for other manufacturer's drivers. (Settings like Bidirectional support may be disabled when doing so. Create new ports for Ricoh devices and all other devices when you install them).

**Windows 7, Server 2008 R2**

**Step 1** Log in to Windows as an Administrator.
**Step 2** Close any open applications.
**Step 3** From the "Start" menu, select "Devices and Printers" > "Add a Printer".
**Step 4** The "Add a Printer" dialogue will be displayed asking "What type of printer do you want to install?" Select "Add a local printer".
**Step 5** The "Choose a printer port" dialogue will be displayed. Create a new "Standard TCP/IP Port" and click "Next".
**Step 6** Enter the "Device" IP address and uncheck "Query the printer and automatically select the driver to use". Click "Next".
**Step 7** The "Install the printer driver" dialogue appears. Click "Have Disk".
**Step 8** Browse to the folder containing the driver files (typically the CD-ROM or an extracted archive downloaded from the website) and click "OK".
**Step 9** Follow the rest of the Wizard's instructions to complete the installation.


**Step 1** Log in to Windows as an Administrator.
**Step 2** Close any open applications.
**Step 3** Open "Printers and Faxes from the Start menu.
**Step 4** Select "Add Printer".
**Step 5** "Welcome to the Add Printer Wizard" is displayed. Click "Next >".
**Step 6** The "Local or Network Printer" dialogue is displayed. Select "Local printer attached to this computer" and click "Next >". Note: Do not enable "Automatically detect and install my Plug and Play printer".
**Step 7** The "Select a Printer Port" dialogue is displayed. Select "Create a new port" > "Standard TCP/IP Port" as the port type and click "Next >".
**Step 8** The "Add Standard TCP/IP Printer Port Wizard" is displayed. Click "Next >".
**Step 9** Enter the device IP address or hostname and click "Next >".

**Step 10** The "Install Printer Software" dialogue is displayed. Select "Have Disk".

**Step 11** Browse to the folder containing the driver files (typically the CD-ROM or an extracted archive downloaded from the website) and click "OK".

**Step 12** Follow the rest of the Wizard's instructions to complete the installation.

---

**STOP**

Please review the Post installation configuration and bidirectional communication verification section below. This could greatly increase printing performance!

---

### Post installation configuration and bidirectional communication verification.

- Once the driver is installed and the queue is correctly configured, make sure that the "Update Now" button is working. Deselect a few options and make sure they are re-selected after "Update Now " is clicked. Also, uncheck "Automatically Update Printer Information". The "Update Now " button and the "Automatically Update Printer Information" check box can be found under the Accessories tab of the driver.

---

**Upgrading the Ricoh PCL6/PS Universal Print Driver to a newer version**

Ricoh recommends using the latest version of the Universal Print Driver, which can be found at [http://ricoh-usa.com/services_and_solutions/universalprintdriver/universal_print_driver.aspx](http://ricoh-usa.com/services_and_solutions/universalprintdriver/universal_print_driver.aspx)

**STOP**

Please review the Key point to follow when upgrading the Ricoh PCL6/ PS Universal Driver section below. This could greatly increase printing performance!

---

### Key points to follow when upgrading the Ricoh PCL6/ PS Universal Print Driver

- Do not use existing non Ricoh UPD queues created for other manufacturer's drivers. (Create new queues for Ricoh devices and all other devices when you install them). Don't simply just click new driver to update the queue to the Ricoh Universal Print Driver.

- A characteristic of a printer that has a driver that was added to a pre-existing non Ricoh UPD queue is the Print Processor may be set incorrectly. Updating the driver via the "New Driver Button", does not change the print processor. The UPD PCL6, for example, has a Print processor of winprint and a data type to RAW. The Print processor can be found under the “Advanced” tab of the driver.

---

**Upgrading the printer driver from an older version (excluding Ver.1.0.0.0) to a newer version:**

**Note:** If upgrading from an earlier version of the driver (Ver.1.1.0.0 - Ver.2.1.0.0), the upgrade procedure might result in changes to the values configured for settings such as orientation and layout.

**Step 1** Open the "Printers" folder (or "Printers and Faxes") from the "Start" menu or "Control Panel".

**Step 2** Open the Properties of the printer to be upgraded.

**Step 3** Advanced tab > New Driver button > Next button.

**Step 4** Select "Have Disk..." then browse to the folder containing the extracted printer driver INF file. Click
Open.

**Step 5** Click OK and select the printer model. Click Next.

**Step 6** Once the installation is complete, click Finish.

**Step 7** Click OK to close the Printer Properties dialog box.

**Step 8** Log the current user account off.

---

**Upgrading an x86 driver installed as an "Additional Driver" on an x64 system (and vice versa)**

To replace an x86 print driver on an x64 server (and vice versa), the following should be done:

**Step 1** Open the Devices and Printers folder.

**Step 2** Select any print queue and open the Print Server Properties window.

**Step 3** Select the "Drivers" tab.

**Step 4** Remove the x86 PCL/PS Printer driver files.

**Step 5** Select "Remove driver only" and click OK.

**Step 6** Click "Add" to install the new version of the x86 PCL/PS Printer driver.

---

**Uninstalling the Ricoh PCL6/PS Universal Print Driver**

Ricoh recommends using the latest version of the Universal Print Driver, which can be found at [http://ricoh-usa.com/services_and_solutions/universalprintdriver/universal_print_driver.aspx](http://ricoh-usa.com/services_and_solutions/universalprintdriver/universal_print_driver.aspx)

**Windows 7, Server 2008 R2**

**Step 1** Log in to Windows as an Administrator.

**Step 2** Close any open applications.

**Step 3** Open the "Devices and Printers" folder from the "Start" menu.

**Step 4** Delete the printer icon corresponding to the driver that is to be uninstalled.

**Step 5** File > Server Properties > Driver tab.

**Step 6** Click the "Change Driver Settings" button.

**Step 7** Select the driver to be uninstalled.

**Step 8** Press the Delete key.

**Step 9** Log the current user account off.

**Windows Vista/ Windows Server 2008**

**Step 1** Log in to Windows as an Administrator.

**Step 2** Close any open applications.

**Step 3** Click the "Printer" icon in the "Control Panel".

**Step 4** Right-click anything in the folder and select "Run as administrator".

**Step 5** Delete the printer icon corresponding to the driver that is to be uninstalled.

**Step 6** File > Server Properties > Driver tab.

**Step 7** Select the driver to be uninstalled.

**Step 8** Press the Delete key.

**Step 9** Log the current user account off.

**Windows XP/ 2k/ Windows Server 2003**
Step 1 Log in to Windows as an Administrator.
Step 2 Close any open applications.
Step 3 Click the "Printer" icon in the "Control Panel".
Step 4 Delete the printer icon corresponding to the driver that is to be uninstalled.
Step 5 File > Server Properties > Driver tab.
Step 6 Select the driver to be uninstalled.
Step 7 Press the Delete key.
Step 8 Log the current user account off.

FREQUENTLY ASKED QUESTIONS

http://social.technet.microsoft.com/Forums/en-US/word/thread/493225be-2d1e-4d14-b663-79ab99d339de/ - Word 2010: large file size sent to the printer. In the printer options, you have to uncheck the option "enable advanced printing features". It appears that the EMF spool file generated by Word 2010 can become very large as soon as images are inserted in the document. By un-checking this option, it is a RAW file (smaller) that is sent to the printer. It should be noted that the problem doesn't present with Word 2007 or 2003.

https://ricoh.custhelp.com/app/answers/detail/a_id/149333/- Printing from Microsoft Office 2010 results in a large spool file. A long delay occurs when you print a large file on a Windows 7 or Windows Server 2008 R2-based computer.

https://ricoh.custhelp.com/app/answers/detail/a_id/14195 - Slow printing: PostScript driver. Print speed can be affected by several things. This answer lists some of the most common, with possible solutions.

https://ricoh.custhelp.com/app/answers/detail/a_id/14191 - Slow printing: PCL driver. Print speed can be affected by several things. This answer lists some of the most common, with possible solutions.

https://tscweb.custhelp.com/app/answers/detail/a_id/122855 - [TA] Printing 1.3: Slow Printing. The Troubleshooting Assistant is a checklist consisting of steps to take in order to troubleshoot, and if necessary, escalate a variety of issues (Note – this article for internal use only. Please contact your technician or TSSC Support Helpdesk for access to this information.)

KNOWN ISSUES

[In General]

* To avoid problems in general, make sure that there is plenty of free disk space.

* With some applications (e.g. CorelDRAW, Visio), complicated images may take a long time to print when the "Graphics Mode" is "Vector". For faster printing, choose "Raster"(Graphics Mode) on the "Print Quality" tab.

* If Graphics Mode is "Raster" then parts of the job might be output as blank unprinted pages. If this occurs, try changing the resolution setting.
[OS/Windows Related Issues]

* Jobs should not be submitted to the queue while the Windows Print Spooler is not running.
* In some cases, Separator pages might result in anomalies.
* Do not change the "Driver" setting in the Advanced tab.

[With Driver Settings]

* [Copies] in [Setup] Tab:

When "Copies" is selected on the driver's "Setup" tab, the value may not be reflected in the application print dialog box. Be sure to set the number of copies only in the driver, not in the application.

* [Staple] in [Setup] Tab:

Documents may not be stapled at the slant angle, even when you select "Top Left Slant" or "Top Right Slant". In such a case, the document will be stapled parallel to an edge of the paper.

* [Booklet/Duplex] in [Setup] Tab:

Printing a large document in booklet, duplex or reverse order printing produce a large temporary file. If you encounter an error when printing a large document in booklet, try again after increasing the free area in system installed drive (e.g. C:).

* [Edge to Edge Print] in [Print Quality] Tab, and [Non Reduction Booklet] in [Setup] Tab:

The use of Edge to Edge Print with Non Reduction Booklet might result in anomalies.

* [Covers] in [Paper] Tab:

Use of a different Paper Source for the cover setting might result in a paper mismatch error. This occurs if the cover is of a different paper size than the rest of the document. This only happens if the cover is not blank and if the source tray for the rest of the document is not "Auto Tray Select". As a workaround, change the print settings so that any one of the above conditions are not met. Note: "cover" = Front Cover, Back Cover or Chaptering Pages

[Graphics/Images]

* Use the "Printing Preferences > Print Quality > Image Processing > Best" setting to clean up noise in printouts.
* When printing particular image data, it may appear noise on the printed document. In this case, select [Best] in [Image Processing] on "Print Quality" tab.

[Fonts/Texts]

* Documents that contain fonts that are not installed on your computer might not print correctly.

[CMYK used for Black and White Documents]

* Black and White documents might be printed in full color (CMYK).
To ensure that the job prints using pure Black (K), please change the color mode to "Black and White" or "Monochrome".

* When selecting "Color" from "Color/ Black and White" setting in the "Setup" Tab, black and white document may be printed as a color job, depending on application or data. If you want to print a document in black and white, select "Black and White" in "Color/ Black and White" setting.

[Help issues]

* Resolution setting of Display is smaller than 800x600dpi, "Information Help" window dialog may be oversized on the display. In this case, to close the window, click "X" button on the right corner of the window dialog.

[Other issues]

* An extra page is added to odd-paged duplex jobs. This blank page represents the blank back side of the last page of the document. Under certain conditions, this blank page might increment the printer's page counter.

* To avoid potential problems, the "Printing Preferences > Paper > Reverse Order" setting shouldn't be used with Duplex, Front cover, Back cover, Chaptering, or Slip Sheets.

* Upgrades with the New Driver button:

If a driver is upgraded using the New Driver button, the setting Automatically Update Printer Information will be disabled.

Note: If there are multiple logical printers using the upgraded driver, only the Automatically Update Printer Information setting of the logical printer used to access the New Driver button will be disabled.

**FIXES**

**Version 4.5.0.0**

**Others**

- Added support for the following models to the "1-5. Supported Models – Printer Driver for Universal Print v4.5.0.0" section:
  - Cor-C1
- Moved the cases regarding printing methods for Citrix XenApp to the “1-4-1. Citrix XenApp” section.
- Added limitations in the Citrix XenApp environment to the "Known issues and limitations“ section.
- Changed the makeup of the slide for the driver upgrade to the “6. Upgrading” section.
- Changed the available version from v3.3.0.0 to v3.1.0.0 when updating Printer Driver for Universal Print v3.x to v4.x.
- Added support for Roaming User Profiles that makes the user-defined One Click Icons and watermarks retained in the user profiles to the “8-7. Roaming User Profiles” section.
Ver 4.5

- Added an explanation about the "Generic Model" selection being listed under "auto" to the "9-1. Generic Model Mode" section.

- Added support for 1200x1200 dpi as a resolution setting when using Generic Model mode to the "9-1-2. Supported Functions (as of v4.5.0.0)" section.

- Changed the range of values for the custom paper size when using Generic Model mode to the "9-1-3. Custom Paper Size for the Generic Model" section.

Version 4.4.0.0

Others

- Added support for the following models in the “1-5. Supported Models – Printer Driver for Universal Print v4.4.0.0” section.
  - DI-C1k (Japanese model)
  - MT-P5 (Japanese model)
  - Luna-P2 (Japanese model)

- Revised the support text for the Citrix XenApp in the “1-3-2. List of Supported Citrix Presentation Server and XenApp Systems” section.

- Added “Korean” to the “1-6. Supported Languages” section.

- Added “Japanese” to the help file in the “1-6. Supported Languages” section.

- Added a new function to the “8-5. Paper Type Selection in Microsoft Word” section.

- Added a new function to the “8-6. Job Type” section.

- Added details about “PCL6 Mode” with the PE-MF4/P4 and RN-MF2/P2 in the “8-10. PCL6 Mode” section.

- Added details about “2 at Center” staple with the Booklet function when using Generic Model

Version 4.3.0.0

Fixed

- When multiple users simultaneously log on to a server that is running a 64-bit operating system, the One Click Preset icon that the user created does not appear in the "One Click Preset List" in Printing Preferences when it is opened from a 32-bit application. Instead, a One Click Preset icon that one of the other logged-on users created is listed.

- When the Printer Properties from an application that supports Print Ticket and Print Capabilities is opened, the Login User Name or User ID is changed from "Defined User ID" or "Create Own ID" to "Windows Login Name" even if the arbitrary User Name or User ID is configured in the driver’s Printing Preferences. This problem occurs if the default Login User Name is customized to "Windows Login Name" by using Printer Driver Packager NX.
- None of the settings, except for the "Copies" setting, that are configured in the Printing Preferences of a driver in Devices and Printers are inherited to the Printer Properties of Windows Photo Viewer.

- The driver authentication data that was configured by using a client in a Point and Print environment might not be output to the print job, resulting in a job cancellation.

- Changes to the duplex setting in Printing Preferences might be ignored.

- When opening Printing Preferences from XPS Viewer, the "Input Tray" that was selected in Printing Preferences from Device and Printers might be ignored and set to Tray 1.

- In an Active Directory environment, an Event ID 322 or 26 error occurs in Print Service if the same paper size exists in the Input Tray Setting List in the Accessories tab of Printer Properties.

- The order of the items in the "Paper Type" setting in the Frequently Used Settings tab is changed when Generic Model mode is selected under "Select Model" in the Accessories tab within Printer Properties.

Others

- Added CAT (Catalog) files which were released from Microsoft (WHQL).

Version 4.2.0.0

Fixed
- Although the "Staple" and "Slip Sheet" settings should not be used together, when one is configured, the other one is still configurable.

Others

- User interface of the driver settings was renewed.

- Two different driver names—the generic name (PCL6 Driver for Universal Print) or a version-specific name (RICOH PCL6 UniversalDriver Vx.x)—can be selected during driver installation, and because of this, these drivers can coexist.

- If the language setting of the device is different from the language of the operating system, print jobs defined as Custom Paper Type encounter a Paper Type Error and are canceled.

- Even if an invalid character is included in the Windows Login Name, the string of characters just before the invalid character is entered as the User ID.

- Support for the Delta Row compression method when printing by using "Generic Model".

- Added CAT (Catalog) files which were released from Microsoft (WHQL).

Version 4.1.0.0

Fixed
- When printing a job that is set to Color, Raster mode, and 1200-DPI resolution, a PCLXL error might occur.

- When printing a document that includes mixed paper sizes and/or mixed paper orientations and setting "Z-fold" to "Right fold" or "Left fold", the documents do not fold properly.
- User Authentication is unavailable on the [Aficio SP 8300DN, SP 8300DN], [Aficio SP C830DN/C831DN, Aficio SP C830DN, SP C830DN/C831DN] and [Aficio SP C730DN, SP C730DN] when these devices do not have an HDD installed.

- Printing via Bluetooth port fails on Windows 8 and Windows Server 2012.

- Model "MP C2530" isn't listed in the "Select Model:" dropdown menu in the Accessories tab of Printer Properties.

- When printing with a job type other than "Normal Print" or "Document Server" without entering a user ID and password into Job Type Details in the One Click Presets tab in Printing Preferences, a warning message does not appear and the job is canceled.

Others

- Added support for the following 15 languages:
  
  - Danish
  - Norwegian
  - Swedish
  - Finnish
  - Polish
  - Czech
  - Hungarian
  - Catalan
  - Turkish
  - Russian
  - Portuguese
  - Brazilian Portuguese
  - Greek
  - Simplified Chinese
  - Traditional Chinese

- Added CAT (Catalog) files which were released from Microsoft (WHQL).

Version 4.0.0.0
Fixed
- When printing by using vector mode and color mode, some parts of the printed result might be blacked out.
- When printing PDF files via PDF-XChange Viewer, the PCL XL error "UnsupportedCharacterFormat" might occur.
- Overall performance has been improved.
- User interface of the driver settings was renewed.
- Some models, which were supported as model-specific devices in v3.13.0.0 or earlier, are now only supported as Generic Models.

Version 3.13.0.0

Fixed
- When setting the following document sizes, which were recently added with the release of [Aficio MP 6002/6002SP/7502/7502SP/9002/9002SP, MP 6002/6002SP/7502/7502SP/9002/9002SP], through Printing Preferences, the document cannot be printed with the appropriate size:
  182x210 mm
  170x210 mm
  210x340 mm
- When setting the resolution of a Microsoft Excel spreadsheet to 300 DPI or 1200 DPI and then selecting the option "Optimize for: Standard (publishing online and printing)" when saving it as a PDF document, the document scales and does not render properly.
- When selecting Print Preview for a Microsoft Excel spreadsheet that is set to a resolution of 300 DPI, the page does not display properly.
- Printing PCL jobs that include the TrueType font causes an SC899 error or a printer hang-up
- 64-bit PCL drivers encounter a PCL XL error, job cancellation, or hang-up when printing dotted lines in jobs from applications such as PDF-XChange Viewer.

Version 3.12.0.0

Fixed
- The driver's resolution setting does not change in accordance with a change in Microsoft Excel's Page Setup > Resolution setting.
- Potential spooler crash on a high-load Citrix XenApp server.
- The "Total Memory" field in the driver's Accessories tab shows an incorrect amount of memory.

Version 3.11.0.0

Fixed
- Various problems populating the driver UI via bidirectional communication.
- Use of the Paper Type "Inkjet Postcard" in the [Aficio 615C, Aficio MP C1500, Aficio MP C1500SP, MP C1500, MP C1500SP, GS 106, SGC 1506, LD215cg, ISC615G] UI or Generic Model UI might result in the error "The handle is invalid." being displayed by the client application.
- Registry entries remain on the system after the driver is removed.

Version 3.10.1.0

Fixed
- Dotted lines printed with the wrong spacing between dots.
- A bug in the scaling algorithm causing images to become distorted.
- Drivers installed via point and print might take a long time to open Printer Properties.
- PCL XL error, job cancellation, or hang-up when printing dotted lines in jobs from applications such as Microsoft Project 2010
- Switching to another printer in an application's print dialogue might take a long time or cause the application to crash. This only affected PCL Universal Print Driver's that had been installed over an older version using the New Driver button.
- The driver version displayed by the driver's About button is incorrect. This only affected PCL Universal Print Driver's that had been installed over an older version using the New Driver button.
- The following product names are missing from the model selection dropdown listbox (Printer Property > Accessories).
  - SP 4400S
  - SP 4410SF
  - SP 4420SF

Version 3.9.0.0

Fixed
- When printing, pop-up dialogues created by the Printer Driver Editor might appear behind the application window. This issue only affects 32-bit applications running on a 64-bit OS.
- PCL XL error "UnsupportedCharacterFormat" produced when printing from IE9.
- The driver is unable to read the correct Accessories names from the InfoPrint/Infotec .PSD files. This causes internal variable names to be used instead.

Version 3.8.1.0

Fixed
- It takes a long time to open the Printing Preferences from within an application if the driver was installed via cross-platform (x86 <-> x64) point and print.

Version 3.8.0.0

Fixed
- The document fails to print if the user account to log in to the OS contains the following characters: []"<>&`
- The "Features" in the General tab are static.
- The Duplex setting will revert to default if the driver's properties are opened from within an application.
- Newer dll files overwritten by older ones when a driver is installed in an MSCS environment.

Version 3.7.0.0

Fixed
- Wording changes for the following settings: "2 sided" is used instead of "Duplex". "Up to 8 digits" instead of "Up to 8 characters of numbers".
- When printing a booklet, watermark could not be printed on all pages.
- Updating to version 3.6.0.0 from any version between 1.1.0.0 and 1.3.0.0, using the New Driver button, corrupts the Watermark list.
- Point and Print client's driver settings that are inherited from the server might return to the default in about 5 minutes after the installation.
- Updating to version 3.6.0.0 from any version between 1.1.0.0 and 1.3.0.0, using the New Driver button, results in the user unable to open the Printing Preferences or Printer Properties window.
- Unavailable options might be selected on the Accessories tab when the user switches the model.
Version 3.6.0.0

Fixed
- Adobe Reader v7.x jobs containing data that is outside of the printable area, trigger a driver bug that results in an application error and nothing being printed.
- The driver was referencing part of driver settings and was retrieving values. This has fixed a problem affecting the use of the driver with Combit List & Label.
- Jobs containing objects that are outside the printable area might result in an error 91 being recorded in the error log.
- The installation of an iPrint printer by a client in a TS session will cause the Print Spooler on the Windows TS server to stop.
- If the iPrint "AllowUserPrinters" parameter is set to 2, it will take longer than usual to open the Printing Preferences of drivers installed on iPrint clients.
- When printing, pop-up dialogues created by the Printer Driver Editor might appear behind the application window. This issue only affects 32-bit applications running on a 64-bit OS.

Version 3.5.0.0

Fixed
- After opening and closing Printing Preferences without closing Printer Properties and then opening the Accessories tab and changing models, the device option names are displayed using internal product codes.

Version 3.4.0.0

Fixed
- The "Automatically Update Printer Information" check box in the Accessories tab will be unchecked after using the "New Driver" button to upgrade from version 3.2.0.0 or earlier.
- Help cannot be opened if "Barrier-free Color Management" is enabled.
- Guests (users who are logged in anonymously) are able to see the Update Now button. After the fix, the button will be grayed out for these users.
- After the driver is installed via point and print, it will take about 2 minutes for the server's settings to be applied to the client. This only affected Windows 7 and Vista point and print clients.
- The Japanese character set "Shift-JIS" might be applied to jobs that do not contain any Japanese characters. This caused some extended-ASCII to appear garbled or not print at all.
- Watermarks cannot be added to the drivers that were installed by point and print because the "Add" button is always grayed out.
- Local administrators were unable to add watermarks due to the bug.
- If the driver is run on an MUI version of Windows XP and Windows 2003, the bottom part of the driver UI might be cut off.

Version 3.3.0.0

Fixed
- Color images printed in grayscale if "Print all text as black" is enabled.
- The Settings > Save/Load function doesn't backup/restore the "Chapter Pages List".
- Switching to this driver from another driver in an application print dialogue, takes a long time.
- Print performance is slow compared to other PCL drivers.
- If the driver is installed using the Windows Print Management console, an error will be shown indicating that rc4man64.dll cannot be copied.
- "Print All text as black" has no effect on PDFs containing embedded fonts.
- Printing a PDF file that contains embedded fonts might result in the job being canceled.
- Open type fonts can not be printed in bold.
Version 3.2.0.0

Fixed
- Print jobs submitted via Novell iPrint printers do not have a "Date / Time" stamp.
- Cross-hatching patterns might be printed larger than shown on the screen. This is known to affect Visio 2000.
- The print settings of the first Excel Worksheet are applied to all subsequent worksheets in the job. This occurred even if "Increase auto-keep settings for applications" was off.
- The front covers of center stapled booklets are pulled from the wrong tray.

Version 3.1.0.0

Fixed
- The Aficio MP C2050/C2550 UI's Advanced Options tab is missing User Authentication settings.
  Note: C9020/C9025 and LD520C/LD525C same as Aficio MP C2050/C2550
- The Aficio MP 171/171F/171SPF UI's User Authentication settings are grayed out if the Hard Disk is not installed.
  Note: 917/917F/917SPF and LD117/117F/117SPF same as Aficio MP 171/171F/171SPF

Version 3.0.0.0

Fixed
- If the duplex option is installed, the bypass tray is not available for selection as an input tray. Only Aficio MP 2550/2550B/3350/3350B,Aficio MP 2550B/2550/2591/3350/3350/3391,Aficio MP 2550B/3350B,MP 2550/2550B/3350/3350B,9025/9025b/9033/9033b,LD425/LD425B/LD433/LD433B is affected.

Version 2.3.0.0

Fixed
- Cannot open Print Properties or print via Novell iPrint if iprint.ini contains "AllowUserPrinters = 2" (forces all printers to be installed as User Printers).
- Jobs submitted to a Windows print server via "Print services for Unix" might be printed in a smaller than expected font size.
- Printing of a PDF document containing embedded fonts might result in the device throwing a PCL error and aborting the print job.
- Locked Print jobs with passwords of 5 - 8 characters in length are not printed.

Version 2.0.0.0

Fixed
- The incorrect English used by the driver's default UI for installations on unsupported local language systems.
- "2 hole" or "4 hole" punch does not work. It is known to affect some models equipped with 2 hole or 4 hole punch units.
- Bi-direction communication on a cluster environment does not work, preventing device accessory information from updating automatically.

Version 1.4.0.0

Fixed
- Documents that include specific fonts are not printed. This is known to affect the Univer55 and Futura fonts.
Version 1.3.0.0

Fixed
- Some driver settings might have no effect if printing from Internet Explorer.

Non-Supported Models

No Fiery controllers

Only models with GW controllers are supported. The only non-GW controller models that are supported are the 4410 and the 3510 in generic mode.

Support models

Aficio SP 9100DN,MLP175n,P7675,SP 9100DN,SP 9100LP275

Aficio MP 2000,9021d,MP2000/DSm721d,MP 2000,IS 2320,MP 2000LD320d,Aficio MP 1600,9016,MP1600/DSm716,MP 1600,IS 2316,MP 1600LD316

Aficio SP 4100N,SP 4100N,MLP31n,LP131n,P7031n,Aficio SP 4110N,SP 4110N,MLP36n,LP136n,P7035n,Aficio SP 4100NL,SP 4100NL,MLP31nL,LP131nL,P7031nL

Aficio MP 4000B,9040b,MP 4000B,MP 4000B/LD040B,Aficio MP 4000,9040,MP 4000,MP 4000/LD040,Aficio MP 5000B,9050b,MP 5000B,MP 5000B/LD050B,Aficio MP 5000,9050,MP 5000,MP 5000/LD050

Aficio SP 8200DN,MLP150DN,SP 8200DN,LP150dn/SP8200DN

Aficio MP C6000,C6055,MP C6000,MP C6000/LD260c, Aficio MP C7500,C7570, MP C7500, MP C7500/LD275c

Aficio MP C4000,C4040,MP C4000,MP C4000/LD540C, Aficio MP C5000,C5050,MP C5000,MP C5000/LD550C

Aficio MP C2800,C2828,MP C2800,MP C2800/LD528C, Aficio MP C3300,C3333,MP C3300,MP C3300/LD533C

Aficio MP C2050,MP C2050,MP C2050/LD520C,MP C9020, Aficio MP C2550,MP C2550,MP C2550/LD525C,MP C9025

Aficio MP C2030,MP C2030,MP C2030/LD520CL,MP C9020L, Aficio MP C2530,MP C2550

Aficio SP C420DN,SP C420DN,LP331cn/SP C420,CLP131DN

Aficio SP C820DN,CLP340D,C8140ND,LP540C/SPC820DN,SP C820DN,Aficio SP C821DN,CLP350D,C8150ND,LP550C/SPC821DN,SP C821DN

Pro 907EX,Pro 1107EX,Pro 1357EX

Aficio MP 6001,9060,MP 6001,MP 6001/LD360, Aficio MP 7001,9070,MP 7001,MP 7001/LD370, Aficio MP 8001,9080,MP 8001,MP 8001/LD380, Aficio MP 9001,9090,MP 9001,MP 9001/LD390

Aficio SP 4210N,SP 4210N,MLP37N,LP37N

Aficio MP 171,MP 171,MP 171/LD 117,917

Aficio MP 201,MP 201,MP 201/LD 220,920
Aficio SP 6330N, SP 6330N, MLP235n, LP235N

Aficio MP C6501, C9065, MP C6501, LD365C, Aficio MP C7501, C9075, MP C7501, MP C7501, LD375C

SP C320DN, Aficio SP C320DN

Aficio MP 2851, 9228, MP 2851, LD528, Aficio MP 3351, 9233, MP 3351, LD533

Aficio MP 4001, 9240, MP 4001, LD140, Aficio MP 5001, 9250, MP 5001, LD150

Aficio SP C430DN, SP C430DN, CLP37DN, LP137CN, Aficio SP C431DN, SP C431DN, CLP42DN, LP142CN

Aficio MP C300, MP C300, LD 130C, Aficio MP C300SR, MP C300SR, LD 130CSR, Aficio MP C400, MP C400, LD 140C, Aficio MP C400SR, MP C400SR, LD 140CSR

Aficio MP C2051, C9120, MP C2051, LD 620C, DSc720, Aficio MP C2551, C9125, MP C2551, LD 625C, DSc725


Aficio SP 4310N, SP 4310N

Aficio MP C3001, C9130, MP C3001, LD630C, Aficio MP C3501, C9135, MP C3501, LD635C

Aficio SP 5200S, SP 5200S, Aficio SP 5210SF, SP 5210SF, Aficio SP 5210SR, SP 5210SR
Aficio SP 5200DN, SP 5200DN, Aficio SP 5210DN, SP 5210DN

MP2352/DSm923, MP 2352, Aficio MP 2352, MP2852/DSm928, MP 2852, Aficio MP 2852, MP 3352, Aficio MP 3352

MP 4002, Aficio MP 4002, MP 5002, Aficio MP 5002

MP C3002, Aficio MP C3002, MP C3502, Aficio MP C3502

MP C4502, Aficio MP C4502, MP C5502, Aficio MP C5502, MP C4502A, Aficio MP C4502A, MP C5502A, Aficio MP C5502A

MP 301, Aficio MP 301

MP C305, Aficio MP C305

MP 6002, Aficio MP 6002, MP 7502, Aficio MP 7502, MP 9002, Aficio MP 9002

SP 8300DN, Aficio SP 8300DN

SP C830DN, Aficio SP C830DN, SP C831DN, Aficio SP C831DN

MP 2001, MP 2501

SP C730DN, Aficio SP C730DN
MP C6502, MP C8002, Pro C5100S, Pro C5110S

MP C3003, MP C3503, MP C4503, MP C5503, MP C6003

Pro 8100S, Pro 8110S, Pro 8120S

MP 2553, MP 3053, MP 3353

MP C2003, MP C2003Z, MP C2503, MP C2503Z

MP C401, MP C401SR

SP C250DN, C250DN, SP C252DN, C252DN

SP C250SF, C250SF, SP C252SF, C252SF

MP 2554, MP 3054, MP 3554, MP 4054, MP 5054, MP 6054

MP C2011

SP 4510SF, MP 401SPF, SP 4510DN, SP 4520DN

SP 3600SF, SP 3610SF, SP 3600DN

Aficio SP 4400S, SP 4400SF, Aficio SP 4410SF, SP 4410SF, Aficio SP 4420SF, SP 4420SF
Support models in Generic mode

The model that supports it as generic mode is the following models.

Aficio MP 3500, Aficio MP 4500, Aficio SP 8100DN, Aficio MP 4000B, Aficio MP 4000, Aficio MP 5000B, Aficio MP 5000, Aficio MP C3500, Aficio MP C4500, Aficio SP C811DN, Aficio MP C2500, Aficio MP C3000, Aficio MP C2000, Aficio SP C410DN, Aficio SP C411DN, Aficio SP C4000N, Aficio SP C420DN, Aficio SP 9100DN, Aficio MP 2510, Aficio MP 3010, Aficio MP 2550B, Aficio MP 2550, Aficio MP 3350B, Aficio MP 3350, Aficio SP 4100N, Aficio SP 4110N, Aficio SP 4100NL, Aficio SP 8200DN, Aficio CL7200, Aficio CL7300, Aficio AP610N, Aficio CL3500N, Aficio CL4000DN, Aficio CL4000HDN, Aficio AP410, Aficio AP410N, Aficio MP 161, Aficio MP 2000, Aficio MP 1600, Aficio 3035, Aficio 3045, Aficio 3025, Aficio 3030, Aficio MP C2800, Aficio MP C3300, Aficio MP C4000, Aficio MP C5000, Aficio MP 6000, Aficio MP 7000, Aficio MP 8000, Aficio MP C6000, Aficio MP C7500, Aficio 3260C, Aficio Color5560, Aficio MP 5500, Aficio MP 6500, Aficio MP 7500, Aficio 3235C, Aficio 3245C, Aficio 3228C, Aficio MP 9000, Aficio MP 1100, Aficio MP 1350, Aficio MP C2050, Aficio MP C2550, Aficio MP C2030, Aficio MP C2530, Aficio 2051, Aficio 2060, Aficio 2075, Aficio 3224C, Aficio 3232C, Aficio MP 2500, MP C1500/615C, Aficio SP 4210N, Aficio SP C820DN, Aficio SP C821DN, Aficio MP 171, Aficio AP900, Aficio MP 6001, Aficio MP 7001, Aficio MP 8001, Aficio MP 9001, Pro 906EX, Pro 1106EX, Pro 1356EX, Pro 907EX, Pro 1107EX, Pro 1357EX, MP3500/DSm735e, MP4500/DSm745e, P7245, MP 4000B, MP 4000, MP 5000B, MP 5000, MPC3500/DSc535, MPC4500/DSc545, C7640nD, MPC2500/DSc525, MPC3000/DSc530, MPC2000/DSc520, C7526dn, C7531dn, SP C420DN, P7675, MP 2510/DSm725e, MP 3010/DSm730e, MP 2550B, MP 2550, MP 3350B, MP 3350, P7031n, P7035n, P7031nL, SP 8200DN, C7528n, C7535n, P7535n, C7521n, C7425dn, P7527, P7527n, MP 161/DSm416, MP2000/DSm721d, MP1600/DSm716, DSm735/735G, DSm745/745G, DSm725, DSm730, MP C2800, MP C3300, MP C4000, MP C5000, MP 6000, MP 7000, MP 8000, MP C6000, MP C7500, DSc460, CS555, MP5500/DSm755, MP6500/DSm765, MP7500/DSm775, DSc435, DSc445, DSc428, MP9000/DSm790, MP1100/DSm710, MP1350/DSm7135, MP C2050, MP C2550, MP C2030, MP C2530, DSm651, DSm660, DSm675, DSc424, DSc432, MP2500/DSm625, MPC1500/GS106, SP 4210N, C8140ND, C8150ND, MP 171, P7575, MP 6001, MP 7001, MP 8001, MP 9001, Pro 906EX, Pro 1106EX, Pro 1356EX, Pro 907EX, Pro 1107EX, Pro 1357EX, Pro 907EX, Pro 1107EX, Pro 1357EX, IS 2435, IS 2445, MP 4000B, MP 4000, MP 5000B, MP 5000, ISC 3535, ISC 4045, IPC 4040DN, ISC 2525, ISC 3030, ISC 2020, IPC 2525DN, IPC 3030DN, IS 2425, IS 2430, MP 2550B, MP 2550, MP 3350B, MP 3350, IPC 2832, IPC 3535e, IPC 2525, IPC 2525e, IS 2416, IS 2320, IS 2316, IS 2235, IS 2245, IS 2225, IS 2230, MP C2800, MP C3300, MP C4000, MP C5000, MP 6000, MP 7000, MP 8000, MP C6000, MP C7500, ISC 4560, ISC 5560, IS 2255, IS 2265, IS 2275, ISC 2835, ISC 3545, ISC 2428, IS 3090, IS 3110, IS 3135, MP C2050, MP C2550, MP C2030, MP C2530, IS 2151, IS 2160, IS 2175, ISC 1024c, ISC 1032c, IS 2325, ISC 615G, MP 171, MP 6001, MP 7001, MP 8001, MP 9001, Pro 906EX, Pro 1106EX, Pro 1356EX, Pro 907EX, Pro 1107EX, Pro 1357EX,

Aficio MP C3001, Aficio MP C3501, C9130, C9135, MP C3001, MP C3501, MP C3001/LD630C, MP C3501/LD635C, MP C3001, MP C3501,

Aficio MP C300, Aficio MP C300SR, Aficio MP C400, Aficio MP C400SR, C 230, C 230SR, C 240, C 240SR, MP C300, MP C300SR, MP C400, MP C400SR, LD 130C, LD 130CSR, LD 140C, LD 140CSR,

Aficio MP C2051, Aficio MP C2551, C9120, C9125, MP C2051, MP C2551, LD 620C, LD 625C

Aficio SP C320DN, SP C320DN,

Aficio MP 201, 920, MP 201/LD 220, MP 201,

Aficio SP 4310N, SP 4310,

Aficio SP 5200S, Aficio SP 5210SF, Aficio SP 5210SR, SP5200S, SP5210SF, SP5210SR,

Aficio SP 5200DN, Aficio SP 5210DN, SP5200DN, SP5210DN,

Aficio MP 2352, Aficio MP 2852, Aficio MP 3352, MP 2352, MP 2852, MP 3352, MP2352/DSm923, MP2852/DSm928, MP3352/DSm933,

Aficio MP 4002, Aficio MP 5002, MP 4002, MP 5002, DSm940, DSm950,

Aficio MP C4502, Aficio MP C5502, Aficio MP C4502A, Aficio MP C5502A, MP C4502, MP C5502, MP C4502A, MP C5502A,
Aficio MP C3002, Aficio MP C3502, MP C3002, MP C3502, DSc930, DSc935,

Aficio SP 4400S, Aficio SP 4410SF, Aficio SP 4420SF,

Aficio MP C305, MP C305, DSc530,

Aficio MP 301, MP 301,

Aficio MP 6002, Aficio MP 7502, Aficio MP 9002, MP 6002, MP 7502, MP 9002,

Aficio SP 8300DN, SP 8300DN,

Aficio SP C830DN, Aficio SP C831DN, SP C830DN, SP C831DN,

Aficio SP C730DN, SP C730DN,

MP 2001, MP 2501

MP C6502, MP C8002, Pro C5100S, Pro C5110S

MP C3003, MP C3503, MP C4503, MP C5503, MP C6003

Pro 8100S, Pro 8110S, Pro 8120S

MP 2553, MP 3053, MP 3353
Ver 4.5

MP C2003, MP C2003Z, MP C2503, MP C2503Z

MP C401, MP C401SR

MP 2554, MP 3054, MP 3554, MP 4054, MP 5054, MP 6054

MP C2011

SP 4510SF, MP 401SPF, SP 4510DN, SP 4520DN

SP 3600SF, SP 3610SF, SP 3600DN

Aficio SP 3500SF, Aficio SP 3510SF, 3500SF, 3510SF, SP 3500SF, SP 3510SF

Aficio SP 3500N, Aficio SP 3510DN, 3500N, 3510DN, SP 3500N, SP 3510DN

Using Generic Model the device will default to color/Black and White mode = color.

**Supported operating systems**

**32-bit architecture**

- Windows XP Home and Professional Editions
- Windows Vista Home Basic, Home Premium, Ultimate, Enterprise, and Business
- Windows 7 Home Premium, Professional, Enterprise, and Ultimate
- Windows 8 Pro and Enterprise
Windows 8.1 Pro and Enterprise
Windows Server 2003 Standard and Enterprise Editions
Windows Server 2003 R2 Standard and Enterprise Editions
Windows Server 2008 Standard and Enterprise

**64-bit architecture**

Windows XP Professional x64 Edition
Windows Vista Home Basic, Home Premium, Ultimate, Enterprise, and Business
Windows 7 Home Premium, Professional, Enterprise, and Ultimate
Windows 8 Pro and Enterprise
Windows 8.1 Pro and Enterprise
Windows Server 2003 Standard and Enterprise Editions
Windows Server 2003 R2 Standard and Enterprise Editions
Windows Server 2008 Standard and Enterprise
Windows Server 2008 R2 Standard and Enterprise
Windows Server 2012 Foundation, Essentials, and Standard
Windows Server 2012 R2 Foundation, Essentials, and Standard

Note: Hyper-V virtual machine environments are not supported.

________________________________________

All brand names and product names mentioned in this document are trademarks or registered trademarks of their respective companies.